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Model the building in ArchiCAD
Add internal zones of rooms
Create thermal blocks
Estimating energy efficiency
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Information about Archicad: e s > s

Y

GRAPHISOFT
* Archicad’

GETTING STARTED COMMUNITY ~ MEDIA RELATIONS

Try Now

.

C GRAPHISOFT. |5:24,

Get your free educational licence here: oz st et ot
Education

Educating students and teachers is a core part of GRAPHISOFT Learn, our official knowledge-sharing platform for anyone interested in
learning about Archicad and BIM.

Look for #graphisoftLEARN to find out more about events, training, webinars, and more!

BUILDING ENERGY ASSESSMENT IN BIM 9


https://graphisoft.com/solutions/archicad
https://graphisoft.com/resources-and-support/education

j{ﬁ.L ECOLOGICAL AND INNOVATIVE TECHNOLOGIES FOR RECOVERING INDUSTRIAL S pCoR A e
Erasmus+ Programme

&ew*er"ﬂ AREAS FROM LCAAND ENERGY EFFICIENCY POINT OF VIEW TSR 5 Lk

Open Graphisoft Archicad
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use the zone tool to create a zone in each conditioned space in the building

by using only the inner edge of the zone structure.

/! Rybaki z rysunkéwé skan - Archicad 26 EDU
nt Options Teamwork Window Help

ile Edit View Design Documes
10 | @ 2 2| = e - @- - Eo -
— =

Design  Layer.

zone tool

Il cgosrod uduomBYI@dLY0 /=0

&) Rybaki z rysunkéw skan - Archicad 26

File Edit View Design Document |
P2X P il N
: Main:

) FEE Sk

Design  lay=r

' | <& 210-A Pomieszczenia 3

‘Construction Method:
& @ BT

Annotation:

et ve

internal tool
edge of the construction of zones

When inserting zones on a plan view check that they are completely surrounded

by zone boundaries.
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Wsunkéw6 skan - Archicad 26 EDU
File Edit View Design Document Options Teamwork Window Help

s \ O Screen View Options b= O~ @ - REXES -0
=t (] Thace Alt+F2 fom =1 " IAction Center]
R @ Construction Grid Display
o £3 Editing Plane Display
Design Trace Options P
! Grid & Editing Plane Options »

U [ Ruter
[B\| Guide Lines L

=
= Guide Line Ogtions 3
Element Snap Alt+E
@ |E Surface Snap
A [£] snap Guides
% Snap Points
Snap Point Options »
+t Grid Snap Alt+S
Grid Snap Options 3
‘Elements in 3D View » & 3D Cutaway
B 3D View Options » 3D Cutting Planes
A ) Structural Analytical Model |&Hﬂu:ﬂd0ul§blmm3ﬂ- Cri+Alt+A a
Q Structural Analytical Model Options ~ »| ‘ff Show Selection F5
& Zoom o G election
< |@ omit o |B Showal
® ;’Q Explore Model
B 30 Navigation Extras ,
4 sy Refresh 3
= open the 3D View tab 4
itz
nl |

= rightclick on it e
= open the "Filtering and Sections window elements in 3D"
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select visible zones

[& Filter and Cut Elements in 30 ? *

Stories to Show in 3D
@) Infinite

() Limited:
To | 2 Poziom +2
From | -1. Poziom -1
Trim Elements to Story range
Marquee Effect
Show Elements: @Ins\de Marquee

() Qutside Marquee

Trim Elements to Marquee

Cut Surface Display
(®) Use Element Attributes

() custom [Rp P
_é . Farba - Antracyt ]

Element Types to Show in 3D

B Mesh o]
LA Roof
W Shell
B curtainwall
@ Morph
= Stair
p‘a Railing
rfb Structural Support
', Sstructural Link
{: Structural Point Load
I} Structural Line Load
m Structural Surface Load
v
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For Energy Assessment purposes,
these Zones should be grouped into thermal blocks

using the Thermal Blocks option J
in the Energy Model Overview palette St

File Edit View Design Document Options Teamwork Window Help

@ e o EmxEe -0
e i ELEcEelE C i 1Action Center]
B MEP Eng »
[t =T
Lol B Story Settings. Ctrl+7
Design Edit Elements by Stories...
! B Edit Story Levels
D [ Section/Elevation Range
= 8 Connect v SR e
- (7 Solid Element Operations... =u
e
I #" Outline Polygon with Magic Wand e
% Magic Wand Settings...
v Convert Selection to Marph(s) o
= Modify Morph o .-
== [, Enter System Edit Mode N
25;] Modiy Railing AN
3 Modity Curtain Wall
Roof Extras v o
. B N dh
esign Extras »
= open the Project tab = e 5%
E Grid System.. PN
[ Update Zones..
[ Model Check v )
' Model Compare [
. e <17
n e n e r eVa I u at I O n tructurel Analytical Model Generation Rules... AR
gy Structural Analytical Elements ,
A% MEP Systems...
'@ [@® Energy Evaluation

= review of the energy model o

Viewpoir
Documer

@ Thermal Bridge Simulation...

€83 Energy Simulation Options...
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0 My
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Py a0y,
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Create a thermal block

Energy Model Review - Thermal Blocks x

& @ = 15

[ Thermal Blocks £} structures  [J® Openings

11
@

¢ use the New thermal

001 Classrooms and rooms

o block buton
B - X
Mew Thermal Block
w Thermal Block Properties |::I
[ | oo wC R | Not Defined 3
ing Systems
Type System Mame P

e the name and ID can
be entered in the list

Start Energy Simulation -
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Energy Model Review - Thermal Blocks X

& v = | = S

i Thermal Blocks Q Structures l' Openings

001 Classrooms and rooms
§ oozwc
& Add Zones to Thermal Black ? X

Add selected Zone(s) to “002 WC" Thermal Elock: v | Show All Zones -

Story Thermal Black

Category »

Layer

D Mame
C Not assigned M Powierzc... 210-A Pomieszeze... ~

Mot assigned

B @ X

. Powierze... 210-A Pomieszeze...

9226  dassroom 1. Poziom +1 Not assigned

[Ey227 classroom 1. Poziom =1 Mot assigned .Powwerzc”. 210-A Pomieszcze...
v
B Mot Defined »
ey gy
System Type System Mame =
Start Energy Simulation -
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Assigning a Zone to a
thermal block:

e use the Add Zones to
thermal blocks option(in
list view)

Note: The zones do not
have to be adjacent to
each other to be combined
into one thermal block.
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2.1. Thermal blocks — user profile

Setting properties of thermal blocks:

= use the command Options> Element Attributes> Usage Profiles

)] Rybaki z rysunkdwé skan - Archicad 26 EDU

File Edit View Design ment  Options | Teamwork  Window  Help
[y Cu | @y R : Element Attributes » = Layers (Model Views)... Ctrl+L
— L\_\\> Property Manager... 2= Lines..
Main:

* ] @ Classification Manager... _U Pens & Color (Model Views)...
S S B Complex Profiles b & Fills..

Design TEI Load Manager... ‘é Surfaces...
|j ' 1 Load Combinations... & Building Materials...

D 4 Load Mapping... | Composites...
b3 Load Categories... I Profile Manager...
Auto Intersection Y Zone Categories...

[
|E8 Operation Profiles...

@}: Add-0n Manager... =
@7 MEP Systems...

Project Pref
S Check Surfaces...

Work Environment

L3
Ué Attributes...

Attribute Manager...
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A separate user profile can be assigned to each thermal block.

e select available profiles or create
your own

e define a daily schedule with the
following data, by hour, for a full year
(8760 hours in total)

e determine the heat output

e demand for hot water

e enter the moisture demand

& Operation Profiles ? bt

AVAILABLE OPERATION PRg

Audytoria/sale wykladowe New...
Eiblioteki [czytelnie)
Biblioteki (ksiegozbiory otwarte}

Rename...

Eiblioteki (ksiegozbiory zamkniete i magazyny) Delete
Biura otwarte

W

Occupancy Data

Human heat gain: W per capita
Service hot-water load: I/day per capita <
Humidity Load: g/day, m*

Mote: Define "Audytoria/sale wyktadowe” profile’s daily schedules and drag them in the order of precedence.

Occupancy type:

MNon residential b

Daily Schedules Recurrence Date Range In use [hours]
. dzien dydaktyczny L4 Mon. Tue, W... (I 02.02 - 15.06
* dzier dydaktyczny Maon. Tue, W... 01,10 - 20,12 1416
= dzier wolny W Sat. sun. All Year 2496
Add Remaove Uncovered: 2544

Edit Daily Schedules...

BUILDING ENERGY ASSESSMENT IN BIM
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Set the required indoor temperature range:

Click: edit daily schedules

@ Operation Profiles ? x
P

AVAILABLE OPERATION PROFILES

Audytoria/sale wykladowe

New...

Biblioteki (czytelnie)
i ?
Biblioteki (ksiegozbiory otwarte] & Daily Profile Editor ! X

Biblioteki (ksiegozbiory zamknigte i magaz

dzier: dydaktyczny

o set the appropriate

Occupangy type:

temperature

Edit profile data in the selected time period

Note: Define “Audytoria/sale wykladowe™ g mc Internal temperature O
Daily Schedules EJ 7 [ Maximum: = °C
a D | 18 -
. drien dydaktyczny 10z B (A pirimu: 1200 e
% dzien dydaktyczny ;
% dzie wolny B J
1 ] 24h
Withe
150 Internal heat gain

: Add Rem; e . [ occupaney count:

Edit Daily Schedules... 0

2 m® per capita

. [ Lighting: Maone

Q

6 2 L 24h Power: 2 wime
O o @b 5 Ob 5 WS [w [Tumw

BUILDING ENERGY ASSESSMENT IN BIM 22



JM1  ECOLOGICAL AND INNOVATIVE TECHNOLOGIES FOR RECOVERING INDUSTRIAL
"Sgge- AREAS FROM LCAAND ENERGY EFFICIENCY POINT OF VIEW

Co-funded by the RaEN
Erasmus+ Programme *
of the European Union T

open a dialog with
Project> Energy Assessment> Installations
in the building

Use this dialog to configure the building
installation settings that will provide
comfortable indoor conditions (as set in
the User Profile window) for the
building model thermal blocks.

=

=

1 4  Architectural Tools
— Structural Engineering Tools
k Main
] MEP Engineering Tools

TEE A HES - (

£ Action Center]

] =
[ By Story Settings...

Edit Elements by Stories...

=]
"
I

Edit Stony Lewels

Section/Elevstion Range

Ctrl+7

% Connect
[87 Solid Element Operations...

# Outline Polygen with Magic Wand
lyg 9
Magic Wand Settings...
=) 5

Conwert Selection to Maorphis)
Medify Morph
Enter System Edit Mode
Medify Railing
Madify Curtain Wall
Roof Extras
Design Extras
4% Grid System .
D%l Update Zones...

Model Check

¥= Model Compare

SIREPEOEICLYO /=04

PR Structural Analytical Model Generation Rules...

(@ Energy Model Review

Structural Analytical Elements
@ MEP Systems...
Energy Evaluation

BUILDING ENERGY ASSESSMENT IN BIM

BB Operation Profiles...

@ Environment Settings...
#¥ Climate Data... M

‘ ‘| Building Systems...

& Energy Source Factors...
@ Energy Costs...

(B Thermal Bridge Simulation...

8% Energy Simulation Options...
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In the Installation dialog box
all installations are shown on

| & Energy Source x

the left and options TR —

Name ~ HEATING SETTINGS

corresponding to each of

O Mot Yet Specified Natural gas 1005

Heating energy sources

() Gruntowa pompa ciepta

them on the right. The ‘

( () On site Equipment
() Kaciot gazowy icienny Boiler or Fumnace

() Kociot olejowy

co nte nt Of the Options for  Komnex Solar Thermal Collector

Water Heat Pump

. . . . EOgnew. migjskie (®) District Heatin otk __
bulldlng Installatlon On the ‘_'t\: spalarnia pelletu z panelem solarnym pran =
G |

.
»
»
Y

% Chtodz. miejskie

rig ht Wi I I C h a nge 3:4 Dachowy agregat chlodniczy 7 DISTRICTHEATING

Include Service Hot-Water Heating [
* Klimatyzator okienny

depending on the selected s R
system configuration. Use the & wemgmai - e o s

Building installations dialog C—

box to edit the properties of

the existing Building
installations, create new ones '=|m>

and assign them to thermal
blocks.
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open the Project> Energy Estimation>
Environment Parameters dialog.
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& Rybaki z rysunkéwé ska

File Edit View Design Document Options Teamwork Window Help

[
N
i =
-
0
]::h
=
A
A
=
e
B
o
==
=
[N
&
=
@
f

o

Viewpair

Documer

A

OlE
By Story Settings... Ctrl«7

Architectural Tools
Structural Engineering Taals

MEP Engineering Tools

3

3

b

> v SR X & -

" 1Action Centen

Edit Elements by Stories...
Bl Edit Stary Levels

[ Section/Elevation Range

&3 Connect
@ Solid Element Operations...

f Qutline Polygon with Magic Wand
A Magic Wand Settings...

Convert Selection to Worphis)
Madify Marph

Enter Systern Edit Mode
Modify Railing
Modify Curtain Wall

Roof Extras

Design Extras
3 Grid System ..
E%l Update Zones...

Medel Check

¥= Model Compare

Structural Analytical Model Generation Rules...

Structural Analytical Elements

@5 MEP Systems...

Energy Evaluation

@ Energy Model Review

## Operation Profiles...

| @ Environment Settings... {

% Climate Data...

+ Building Systems...

£ Energy Source Factors...

%) Energy Costs..

(B Thermal Bridge Simulation...

8} Energy Simulation Options...
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Location setting
The energy estimate takes the geographic location of the building into account when
retrieving climate data from the StruSoft climate server.

= click on location settings

Location and Climate:

|52"15' ON2I°0C0E ‘ ‘ Location Settings...

. p rOVi d e th e ad d reSS Of th e ‘Chmat: source: POL_ Warszawa.Okecie.1 ‘ Climate Data... ﬁ Location Settings ? %
iInvestment T QR p— /

(®) Offset Distance |O,DO | Project Name: Edit.
' Modeled by Mesh Elements Site Full Address: Edit..
. Surface Heat Transfer...
= enter the width | e ale

an d I 0 n Itu d e Thefmal conductvy R Time Zone (UTC): | WTC=01:00) Afr..dkowozachodnia |
Density 2200,00 kg/m’

Altitude (Sea Level): 60l Y om
Heat Capacity 1900,00 J/kgk \% 3
Show in Googl 0]
Surroun dings: |GE’dE” Vl - @ PROJECT NORTH
= enter your time zone T | e
Harizontal Shading... %
H ) Data Loading... =
= enter elevation ’
above sea level CER
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& Environment Settings ? X

Location and Climate:

.
SOI I type ‘52“15' O N21I"0C0E | Location Settings...

Se | ect : O ptio n S fro m t h e Wi n d OW’ @ |Climatesuurce: POL_Warszawa.Okecie. 1 | Climate Data...
which best suits i O

O Modeled by Mesh Elements

soil type at the site
buildings.

Surface Heat Transfer...

Soil Type: Clay v

Density 1800,00 kg/m*

Heat Capacity 1000,00 1/kgK

Surroundings: ~

‘Wind Protection...

Thermal Conductivity 0,500 W/mkK

Surroundings
choose an environment that best describes
the conditions for a given building location:
Water, Garden, Paved or your own.

Harizontal Shading...
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Wind exposure /@ wind potecton r X
select the appropriate Wind @ enivonment setins |
Exposure Level for each Eoenmoos |
orientation of the building. (e |
Shrouded, Partially Shrouded, or e e |
Unprotected. For each i |
orientation, a point will be =
inserted on the graph that Themma Conduciviy 0
represents Wind exposure (the e oy o

Orientation Wind Protection

fU rther the pOint iS, the higher Surroundings: Paved ::::East }};E::I;o::i:ed /
the exposure factor) and the S e Ly o

LUnproted:ed .-
points are connected by a red '—L"? L Unproteced

Wit

| SouthWest T Unprotected
. West L Unprotected
I I n e . Morthwest Lunprotected
Cancel
] (W
Cancel QK [
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Horizontal shading
Model-Driven Solar Analysis in
ARCHICAD's Energy Estimation
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|52°15‘ O°N,21°0°0°E

| Location Settings..

only works on the translucent

@ |Clwmate source: POL_Warszawa, Okecie.1 | Climate Data...

parts of the building envelope. -
However, it does not Sz
automatically determine the

O Maodeled by Mesh Elements

extent to which shadows are R
cast by external objects onto -
the opaque parts of a building.
Using the Horizontal shading

to Project Zero [P

| 0,00

Surface Heat Transfer... —
| @ Horizental Shading X

Clay
Crientation Shading
0,500 East ! High
SouthEast H Low
1800,00
South L Mone

1000,00 | 50 uthwest T4 Low

Wind Protection...
Mote: Crientation is dependent on Project Location;

Horizontal Shading.. therefore, some orientations may not be available.

button, activate a separate =>

dialog with a list of sunny sides
of the building (the Orientation
list may differ depending on
the project location).
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Climatic data

. f& Environment Settings 5 %
e click Download from Strusoft
. |52"15‘ 0N, 21°0'0°E | Location Settings...
Server. All meteorological data (@) o o] e
on the StruSoft website is ﬂ© rox
@ Offset Distance Climate data is ready for simulation

generated from data collected e B
by NCEP facilities obtained | @ <F

fro m t h e N OAA- C I R E S ;:::T[:I e Climate Type: Climate Zone Identifier:
meteorological research center

in Boulder, Colorado (USA) at S

Heat Capacity

Data Type: °C [» Views

| [air temperature VB EE O
http://www.cdc.noaa.gov/. | =
e click on a data type to view
the table: Air Temperature, .
Relative Humidity, Sunshine or |-

Jan. | Feb. | Mar. | Apr. | May. | Jun. [ Jul. | Aug. | Sep. | Oct. | Mow. | Dec.

Wl n d S p e e d * T Maximum: : 3628 I Average: 13.23 _z Minimum:  -2.81
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2.4. Thermal blocks - Structure property settings

U-factor calculator
The U refers to the heat transfer coefficient of the selected structure.
The layers that make up the selected structure in the U-value calculator are listed along with
their specific properties (thickness, thermal conductivity, density and heat capacity). To be
able to modify them:

Energy Model Review - Structures x
& @D = I @
(@ Thermal Blocks Q structures [J® openings

Type Orientation  C... Thermal Block Name ea [m7  Thickness... U-value [W/mK] Infiltration [I/sm7 Solar Absarg ¥

. . .
0 click the ellipsis
I oot Classroodd — 4 g | 55000 Qo £
. ,,,,, .
Dioncmd e o [ P | owo our N - button in the
>slab  Bottom ] Interval: 0,04 - 1,90 24,00 & 325 1,10 85,00
[Jwall  Inner (001 Cla... [ 42,00 & o058 0 - U _f t I _
[Dwall  Inner wo2wa [T ooz we S (e R O 16,00 [ o — a C 0 r CO u m n
[JWall  Inner (003 Sta... [T [ 003 Staircase Wedium - mason - ~] 55,00 & o045 e
[Jwall  Boundary 00... [ ] 001 Classroon 42,00 @ 059 0% When the ad Iock
[Jwall  Boundary (00... [0 | 003 Staircase e 42,00 & 059 0% e p
[Jwall  South [ § 001 Classron 6,00 @ 039 1,10 85,00 . .
[Dwall  East I 1 001 Classrooms an... B777] 114-57 Ceramiczna 64 tynk 43,43 66,00 & 039 1,10 85,00 I Co n I S C I ose d
[Jwall  North [ | 003 staircase an d c.. 274 212-5W Ceramiczna 57 tynk 46,73 55,00 @ 048 1,10 85,00
[Jwall  North [ § 001 Classrooms an... E777] 114-52 Caramiczna 64 tynk 45,81 6,00 @ 039 1,10 85,00 .
[wan west [ § 002 we 727 114-52 Ceramiczna 64 tynk 43,45 66,00 & 039 1,10 85,00 ( red ) - to b rl ng u p
[Jwall  Boundary (00... [ [J 001 Classrooms an... B8 311-5D ceramiczna 12 tynk 42,89 16,00 & 078 [ —
[Jwall  Boundary (00... [ [ 002 WC F27H311-5D Ceramiczna 12 tynk 4289 16,00 @ 078 0% e h U f
[Jwall  South [ § 001 Classraams an... §212-5W Ceramiczna 51 tynk 39,44 55,00 & o048 1,10 85,00 t e = a Cto r
£ slab  Upward [ # ooz we -PS Strop drewniany - parkiet 38,91 30,00 & oss 1,10 85,00
> Slab Bottom . IOOZWC -PS Strop drewniany - parkiet 3891 30,00 @ 059 1,10 85,00 Ca I C u I ato r d i a I o
[Jwall  Inner (003 Sta... [[] | 003 Staircase an d c... P27 211-5W Ceramiczna 38 tynk 16,66 42,00 & ose - g .
[Jwall  Boundary (00... [ [J 0oz we E77A 2125w Ceramiczna 57 tynk 14,58 55,00 @ 046 0% ~
< >
9 Areathreshold: 0,00 m? @
Start Energy Simulation -
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Before starting the energy simulation of the energy balance

click the Update energy model button

Energy Model Review - Thermal Blocks
N ate Aodel Review =B
Ey .
e openmas

m
@

Energy Model Review - Thermal Blocks X
8o B = @
Now we can start the ® e [
~ 1 001 Classrooms an d rooms ~
- o [EY 202 dassroom
simulation = e
[EY 204 dassroom
B @ X
[EY 205 dassroom
energy balance =
[Z5 207 roam
ﬂ’a|m nnnnnnnnnn d rooms | B8 | Audytoria/sale wykladowe >
[Z5 208 reom
Supply Building Systems 24 209 room
System Type System Name o= 2 210 room
N
¢ () Heating Ogrzew. migjskie 5 211 room v

. click the button Start ° o

= Thermal Block Properties

energy balance simulation == e BEES

Supply Building Systems

System Type System Name ot
Start Energy Simulation - 4 () Heating Ogrzew. migjskie
¢ (@) Ventilation Wentylaga grawitagzina
ﬁ Start Energy Simulation =
Start Energy Simulation |
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e
TG 152

=N

The built-in, certified VIP-Core
module performs a dynamic
energy simulation that

calculates the hourly energy —— — m—

balance in the building and E—— KT :
generates the report on the e I o
energy balance in the N =

16574

230857
3

building. The report contains
information on, inter alia,
energy efficiency of structures
in the project, the annual
energy consumption, energy

balance and the Ievel Of Add/Remove Page Break: (o]
carbon dioxide emissions. - | A——
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d d the simulati
@ Fuluston Repor v x We conducted the simulation
‘
S ’ to the 3rd floor of the buildin
» REPORT FORMAT Oszacowanie wydajnosci energetycznej g
[Project Number] PROJEKT
~ REPORT CHAPTERS
Select Chapter(s) to Report: Key Values
» n General Project Data Heat Transfer Coefficients U value WimK]
Key Values 1 Project Name PROJEKT Building Shell Average: 034
- : « it Floors: -
2 | Energy Consumption by Sources 1 - v D34 925
. . 0 0E Underground -
¢ |4 Energy Consumption by Targets 2 S o Opestngs Toon0
B i C ata Source: Strusoft server
E Project Energy Balance 3 Ewaluation Date: 07.12.2022 15:01 Specific Annual Values
¢ |4 Thermal Blacks 3 Net Heating Enemy: 6252
Buildina Geometrv Data Net Coolina Enerav: 000
= E Environmental Impact 3 Grass Floor Area: 8688 m Total Net Energy 62,52
Treated Floor Area 705.0 m Eneray Consumptin 241.21
Exte lope Area: 16574 m Fuel Consumption: 24121
Ventiated Volume: 230857 m Primary Enery. 27784
Glazing Ratio E Fuel Cost —
€02 Emission 196
Building Shell Performance Data
Infitration at 50Fa 3355 ACH Degree Days
Heating (HOD): 4n502
Cooling (CDD} 1236.82
Energy Consumption by Sources
Energy. €02 Emission
Source Type Source Name Quaniity Primary Cost
MWh'a MWhia PLN/a kgl
Secondary ] Elec'.riciry f a? - 2780
@ District Heating 57 57 - 0
Total: 170 195 Not Applicable 2789
Energy Quantity Primary Energy
. .
e page Eesc olfe We can save the simulation
Chapter Settings
-~ results to PDF
K4
Format Settings Import/Export 3 Close Save as PDF... -
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